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Welcome 
ElecNet provides state-of-the art visualization to help you easily build 2D and 3D models for 
electrostatic, DC current flow, time-harmonic, and transient analysis. Infolytica’s leading edge 
technologies transparently generate the finite element mesh and quickly provide accurate field 
solutions.  

The structures which can be simulated with ElecNet include: 

 Power transformers 
 Biomedical applications 
 Implants 
 Electrical insulators 
 Connectors 
 Micro-motors 
 Micro-actuators 

Learning ElecNet 
Your ElecNet documentation package consist of this Getting Started Guide and Tutorials in an 
electronic media format (i.e. PDF files), and also includes a comprehensive HTML Help 
(ElecNet.chm) system. 

Getting Started Guide Tutorials 

 Installation instructions  
 Introduction to modeling 

 2D Electrostatic Tutorial: Spheres 
 2D Current Flow Tutorial: Conductance 

of a trimmed resistor 
 2D Time-harmonic and Transient 

Tutorial: Microstrip 
 3D Electrostatic and Transient Tutorial: 

Microstrip 

Additional help is available by visiting the Support section of our website: 

  Live Docs -- an integrated and centralized source of up-to-date documentation  

Additional information 

More information on the procedures and concepts of model building with ElecNet is found in the 
Help included with each package.  

Note The ElecNet Help menu provides easy access to the PDF versions of this Getting 
Started Guide and the Tutorials. 
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Overview 

This chapter contains instructions for: 

 Installing ElecNet 

 Obtaining a license key file for ElecNet 

 Installing a ElecNet node-locked license  

 Installing the License key server  

 Installing a floating (network) license key file for ElecNet 

 Connecting a node to the license key server 

 Where to contact Customer Support 

 

For system requirements, please refer to:  

 http://www.infolytica.com/en/products/elecnet/requirements.aspx 

 

Note that ElecNet requires Microsoft® Visual Basic®, Scripting Edition (VBScript) to run. The 
ElecNet setup program will install VBScript on your computer. 
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Installing ElecNet from a CD 
The procedure is identical, whether you are installing ElecNet as a new system or as an update.  

1. Insert the ElecNet CD into the drive. 
2. From the Windows START menu, select Run. 

If Run command line is not listed, press keys Windows Logo + R to open the Run dialog.  
3. In the Open text box of the Run dialog, type the following: 

D:\setup.exe 
(where D is the name of the CD drive). 

The ElecNet Setup program is initiated. 
4. Follow the instructions given by the Setup program. 

Note Copies of ElecNet are shipped without a license key file. You will need to run the 
Client ID program to obtain a license key file. Please see “Obtaining a license key 
file for ElecNet” on page 4. 

Note If the Microsoft Scripting Setup program prompts you to re-boot the computer 
after installing VBScript and JScript, or after installing DCOM, do not re-boot at 
that time. Please wait until the ElecNet Setup program prompts you to re-boot. 
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Obtaining a license key file for ElecNet 
A license key file can be node-locked (single-user) or floating (network-based). To obtain a 
license key file, you must run the Client ID program. The Client ID program displays 
information about your computer that you must send to Infolytica Customer Support. The client 
information provided by the Client ID program will be used by Infolytica Corporation in the 
preparation of a license key file. 

The Client ID program can be run from the Windows’ Start menu created by  the Setup program.  

 For instructions on installing a node-locked license, please see “Installing a ElecNet 
node-locked license” on page 5. 

 For instructions on installing a floating license, please see “Installing a floating (network) 
license key file for ElecNet” on page 6. 

To obtain a license key file 
1. From the Windows’ Start menu, navigate to All Programs/Infolytica/ElecNet <version 

number> Docs & Tools, and then click "Client ID". 
The Client ID dialog appears. 

 

2. In the Client ID dialog, do one of the following: 

 Click “Send E-Mail” -- This action opens your default e-mail account and automatically 
places the contents of “Client Information” into the body of the e-mail message. 

 Click “Copy To Clipboard” – This action requires that you open your e-mail account 
and paste (press CTRL+V) the contents of the “Clipboard” into the body of the e-mail 
message. 

3. Important -- Add the following information to the e-mail message: 

 Your name 
 Your affiliation (e.g., company name) 
 The version of ElecNet you have installed (e.g. ElecNet 7.1.2) 

4. Send the e-mail to your Customer Support representative. (please see “Where to contact 
Customer Support” on page 9 for the appropriate e-mail address -- for example, if you reside 
in Canada or the United States, you would send the e-mail to support@infolytica.com). 
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Installing a ElecNet node-locked license 
Note This procedure assumes that you have obtained a license key file (ElecNet.lic) 

from your Customer Support representative and placed it in a temporary folder 
(e.g., C:\Temp). If you still haven’t requested a license key file, please see 
“Obtaining a license key file for ElecNet” on the previous page. 

1. From the Windows’ Start menu, navigate to All Programs/Infolytica/ElecNet <version 
number> Docs & Tools, and then click "Client License Key File Administrator”. 
 The Client LicenseKey File  Administrator dialog appears. 

 

2. Select the option ”Use a local license key file”. 
3. In the License key file text box, type the path (e.g., C:\Temp\ElecNet.lic), or browse to the 

location of the license key file that you have received from your Customer Support 
representative. 

4. Click the Configure License key file  button. 
5. At the “Backup and Replace File?” prompt, click Yes. 

The new license key file is installed. 

Installing the License key server 
This procedure installs the Infolytica License key server on the computer designated as the server 
in a network environment. 

1. Insert the ElecNet CD into the drive. 
2. From the Windows Start menu, select Run. 
3. In the Open text box of the Run dialog, type the following: 

D:\LicenseServer\setup.exe 
(where D is the name of the CD drive). 

The License key server Setup program is initiated. 
4. Follow the instructions given by the Setup program. 

Note Once the setup is complete, you will need to run the Client ID program on the 
server to obtain a floating license key file. Please see “Obtaining a license key file 
for ElecNet” on the previous page. 
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Installing a floating (network) license key file for ElecNet 
The following instructions describe how to install a floating (network) license key file on a 
license key server. 

Note This procedure assumes that you have obtained a floating license key file 
(ElecNet.lic) from your Customer Support representative and placed it in a 
temporary folder (e.g., C:\Temp). If you still haven’t requested a license key file, 
please see “Obtaining a license key file for ElecNet” on page 4. 

 

1. From the Windows’ Start menu, navigate to All Programs/Infolytica, and then click 
“Infolytica License key server Administrator <version number>”. 
 The License key server Administrator  window appears. 

2. Click the Add/Update button. 
3. From the Open dialog, locate the license key file (e.g., C:\Temp\ElecNet.lic), then click 

Open. 
4. In the License key server Administrator  window, click Close. 

If the License key server is not already running and you are prompted to start it, click Yes. 
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Connecting a node to the license key server 
Note This procedure assumes that you have obtained a license key file (ElecNet.lic) 

from your Customer Support representative and installed it on the license key 
server. Please see “Installing a floating (network) license key file for ElecNet” on 
page 6. 

1. From the Windows’ Start menu, navigate to All Programs/Infolytica/ElecNet <version 
number> Docs & Tools, and then click "Client License Key File Administrator”. 
The Client License Key File Administrator dialog appears. 

 

2. Select the option ”Use a license key server”. 
3. In the License key server name text box, type the name of the Server (e.g., Avatar). 
4. Click the Configure License key file button. 
5. At the “Backup and Replace File?” prompt, click Yes. 

The applications will now connect to the floating license key server the next time they are 
started. 
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Where to contact Customer Support 

North America and International (outside of the areas that are listed below) 
Infolytica Corporation 

Telephone:   + 1 514 849 8752 ext. 600 
Fax:      + 1 514 849 4239 
E-mail:     support@infolytica.com 

Europe 

Infolytica Limited, UK 
Telephone:    + 44 (0) 1327 810383 
Fax:      + 44 (0) 1327 552383 
E-mail:    support@infolytica.co.uk 

Japan 

Adtech Co. Ltd. 
Telephone:   + 81 3 5475 1540 
Fax:      + 81 3 5475 1541 
E-mail:    support2@ad-tech.co.jp  

India 

Tessolve Semiconductor Pvt. Ltd. 
Telephone:   + 91 80 4181 2626 
Fax:      + 91 80 4120 2626 
E-mail:    sundararajan@tessolve.com 

China 

Beijing Hi-key Technology Corp Ltd 
Telephone:   + 86 10 8231 8880  
Fax:      + 86 10 8232 4448 

E-mail:    guwg@hikeytech.com 

Korea 

VFK Inc. 
Telephone:   + 82 54 223 2431 
Fax:      + 82 54 223 2430 
E-mail:     koni@vfk.co.kr 

Taiwan 

Alpha Precision Instrumentation Corporation 
Telephone:   + 886 02 2508 3066 
Fax:      + 886 02 2507 7185 
E-mail:     Lister@apic.com.tw 
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Introduction to model building 

An ElecNet model is made from a geometric model to which materials, boundary conditions and 
excitations are assigned. After the model is solved, field plots and numerical results are available 
for viewing. The finite element mesh of the model can be customized to increase solution 
accuracy. 

 

Modeling flowchart 
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Geometric modeling 
The geometric model is constructed from three basic building blocks: 

 Edges  
 Surfaces 
 Components 

Edges 

Edges are lines and arcs. They are drawn on the construction slice in the View window. 

 

The construction slice is a two-dimensional editing plane that can be moved forward and 
backward in space. Edges drawn on the construction slice move with the slice and remain in 
view until they are intentionally removed by the user. 
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Surfaces 

Edges are drawn to create surfaces. Surfaces are swept to create three-dimensional components. 
A surface must be “closed” before it can be swept to create a component. 

 

Components 

Components can be swept in a positive or negative direction: 

 For an arbitrary length 
 In a circular arc through any angle 

 

By drawing and sweeping surfaces, additional components are added to form an entire model. 
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Drawing edges 
Edges are drawn using the Draw toolbar and either the mouse pointer or the Keyboard Input bar. 
You can draw lines, arcs, or circles. 

 

Edges are drawn on the construction slice.  

Note Edges are saved with the model even if the user has not swept the geometry 
before closing. 

Lines 

Using the mouse pointer 

Lines are drawn as polylines. That is, line drawing is continuous until you press ESC or double-
click the mouse. 

 

Using the Keyboard Input bar 

Lines are entered as coordinate PAIRS. The last coordinate PAIR entered becomes the start 
coordinate PAIR of the next line. To stop drawing, or to begin a new line, press ESC on your 
keyboard. 
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Arcs 

Note When drawing an arc using the mouse 
pointer or keyboard, ElecNet automatically 
adjusts the end point to have the same radius 
from the center point as does the start point.  

 

Using the mouse pointer to draw an arc 

Three different methods exist, when using the mouse pointer, for drawing arcs in ElecNet. 

 Arc (Center, Start, End)  

 Arc (Start, Center, End)  

 Arc (Start, End, Center)  

Note Arcs are drawn in a counter-clockwise direction.  
 
Holding the Ctrl key down, while drawing the arc, inverts the direction of the arc. 
The arc is still created counter-clockwise; it is only the start and end points that 
are inverted. 
 
A “rubber-band” line follows the movement of the mouse pointer.  

 

Using the Keyboard Input bar to draw an arc 

Arcs are drawn by entering three coordinates, in the order that corresponds to one of the three 
chosen method s (see above for reference): 

 Center point, Start point, End point 
 Start point, Center point, End point 
 Start point, End point, Center point 
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Circles 

Note After a circle is 
drawn, ElecNet 
automatically segments 
the circle into two arcs. 

 

Using the mouse pointer to draw a circle 

Two different methods exist, when using the mouse pointer, for drawing circles in ElecNet. 

 Circle (Center, Radius)  

 Circle (Radius, Center)  

 

Note A “rubber-band” line follows the movement of the mouse pointer. 

Using the Keyboard Input bar to draw a circle 

Circles are drawn by entering two coordinates, in the order that corresponds to one of the two 
chosen methods (see above for reference): 

 Center point, Point on the radius of the circle 
 Point on the radius of the circle, Center point 
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Segmenting edges 

Edges are not automatically segmented at the point of intersection with other edges. Only when 
the user has selected the specific edges, and then clicked Segment Edges on the Model menu, do 
the lines segment. 

 

Snap modes 

The snap modes control the location of entry points made with the mouse pointer. There are 
seven snap modes: Grid, Endpoint, Intersection, Nearest, Center, Tangent, and Perpendicular. 

 

None Points appear exactly where the mouse pointer clicks in 
the display. 

Grid Snaps to the nearest grid point. 

Endpoint Snaps to the nearest endpoint of existing edges. 

Intersection Snaps to the nearest endpoint of existing edges or the 
intersection between existing edges. 

Nearest Snaps to the nearest point on existing edges – any point. 

Center Snaps to the nearest existing arc center. 

Tangent Snaps to the nearest point on Construction Slice, where 
edge being drawn becomes tangent. 

Perpendicular Snaps to the nearest point on Construction Slice, where 
edge being drawn becomes perpendicular. 

 

Note Tangent and Perpendicular snap modes behave like None for the first point of an 
edge because a point alone cannot be tangent or perpendicular. 
 
A line being drawn may also become tangent or perpendicular at its first point, if 
this point resides anywhere on an existing edge. Hence, using Endpoint for the 
first point, and Tangent or Perpendicular for the second point, allows prolonging 
an existing line or drawing a line perpendicular to it. 
 
The snap mode stays in effect until a new snap mode is selected. Select None 
from the Draw menu to turn off the snap mode. 
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Creating surfaces 
Surfaces are the basis of 3D components. Surfaces are 2D regions formed by:  

 Edges drawn on the construction slice 
 2D faces of 3D components 

Construction slice surfaces 
Surfaces drawn on the construction slice must be “closed” before they can be selected. 

 

After a surface has been made into a component, the edges of the surface are duplicated in the 
component. The original edges remain on the construction slice.  

Note To remove the construction slice edges, select all of the edges and  
then click Delete on the Edit menu. 

Moving edges with the construction slice 
Edges can only exist on the construction slice. If the construction slice is repositioned, all edges 
move with the construction slice. For example, in the diagram below, the construction slice, with 
edges, has been moved 2 meters in the positive Z direction.  

 

Note Edges on the construction slice are saved with the model. 

Component surfaces 
Components can also be created from the 2D surfaces of other components. 

 

Extracting edges 
After a surface has been made into a component, the edges of the surface are duplicated in the 
component. You can copy the edges of a component’s surface to the construction slice using the 
Extract Edges command.  

Note The construction slice must intersect the surface. 
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Creating components 
Components are created from surfaces (see “Creating surfaces” on page 8) or using the CSG 
Modeling technique (see page 11). Components can be swept in either a linear or rotational 
direction.  

Note If you are using the Extrusion modeler, all the components of the model must be 
swept in the same linear or rotational direction.  

 

Default sweep direction 
The default sweep direction for a component is positive (sweeping out of the construction slice 
or out from the surface of a component).  

 

Creating multiple components simultaneously 

More than one surface can be selected to create a component.  

Note When multiple components are created simultaneously, all components share the 
same material and sweep distance. You can later change the properties of any 
component in the Component property and parameter pages. 

In the model below, three surfaces exist. You can sweep all of these surfaces at the same time. To select 
all three surfaces, hold down the SHIFT key while selecting each surface. After all the surfaces are 
selected, you can use the Make Component tool. 

                        

Tip When you press SHIFT or CTRL as you select objects, every object you click on 
remains selected. Pressing CTRL as you select objects also enables you to click 
on an object a second time to de-select the object. 
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Changing component properties 
The properties of a component are changed in the Component Properties dialog, which consists 
of seven pages (General, Sweep, Mesh, Mesh Layers, Material, Charge, and Parameters). 

 

You can change the following properties: 

 Name 
 Polynomial order (3D models only) 
 Initial Temperature 
 Enable/Disable the component 
 Line, arc, or multi-sweep settings 
 Maximum element size 
 Curvature Refinement minimum 

element size 
 Curvature Refinement angle 
 Mesh Layer type (Uniform, 

Logarithmic, User-defined) 
 Material 
 Material direction  

 Charge density for the volume (in 
Coulomb/length3) 

 Parameters for: 
 Charge density for the volume (in 

Coulomb/length3) 
 Material 
 Material direction 
 Position of the starting surface of the 

component 
 Sweep distance 
 Maximum element size 
 Polynomial order (3D models only) 
 Geometric position 
 Angle of the start and end surfaces (3D 

models only) 
 etc. 

Modifying component edges (chamfer or fillet) 
This feature allows you to modify your model at the component level by selecting an edge, or 
edges, and transforming them to a chamfer or rounded edge. 

Selected edge Chamfered  
symmetric edge 

Chamfered  
asymmetric edge 

Filleted edge 
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Creating components using the CSG Modeling technique 

Various shapes and forms can easily be created using a modeling technique known as 
Constructive Solid Geometry, or CSG.  

Sphere 

  

Rectangular 
Block 

  

Cylinder 

  

Cone 

  

Torus 

  

Prism 

  

Pyramid 
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Selecting edges, surfaces, and components 
Objects are selected with the mouse pointer using one of the selection tools on the Edit menu or 
Selection toolbar, or by creating a selection box.  

 

An object must be selected before a property or action can be applied to it. For example, a 
construction slice surface must be selected before it can be made into a component. The object is 
highlighted when it is selected. 

 

Selection box 

You can draw a selection box to highlight several objects at once. A selection box is also useful 
to highlight only certain items. For example, to find all the available edges on the construction 
slice, you can draw a selection box (using the select Construction Slice Edges selection tool) to 
highlight the edges. 
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Positioning the construction slice 
The construction slice is a two-dimensional editing plane in the View window that can be moved 
forward and backward in space. 

The initial position of the construction slice is in the XY plane of the global XYZ coordinate 
system. The slice is first located at Z=0. The construction slice can be moved forward and 
backward using the Move Construction Slice dialog box. This dialog is accessed from either the 
Draw toolbar or the Draw menu. 

 

The construction slice can also be moved to a selected surface of a component.  

 

When a component is swept, the start surface of the component begins on the construction  
slice. The end surface of the component is determined by the sweep distance set in the  
Make Component dialog.  

Note The construction slice does not move when the component is swept. 
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Materials 
Materials are added to the component during the sweeping process.  

 The Model Materials library lists all materials assigned to the device.  

 The User Defined Materials library contains material that you have created or modified. 

 The Materials page contains hundreds of pre-defined materials (sorted by database) that can 
be applied to the model, including electrical conductor and electrical insulator materials. 
Each material can be assigned to several categories.   

Note Any of these pre-defined materials can be modified to make a user-defined 
material; you must first copy the pre-defined material to the User-defined 
materials library and then make the appropriate changes in the Material Property 
dialog.  

The contents of the material library are shown in the Material page of the Project bar. 
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Boundary conditions 

Boundary conditions define the behavior of the electric field at the boundaries of the model. 
Boundary conditions are applied to surfaces of the model, or to surfaces of an air box that 
represents an artificial outer boundary that surrounds the model. Conditions of symmetry can 
also be represented by using the appropriate boundary condition. 

ElecNet provides five boundary conditions: 

Ground: Constrains the electrical potential to zero. The electric field is made normal 
(perpendicular) to the boundary. 

Flux Tangential: Constrains to zero the normal component of the electric flux density. The 
flux is made to flow tangential to (along side) the boundary. The Flux Tangential boundary 
condition is applied by default to all surfaces of the model that are not assigned the Flux 
Tangential boundary condition. 

Even Periodic: If symmetry conditions exist, you can use the Even Periodic boundary 
condition to model sections of a periodic structure with an even number of poles. The mesh 
nodes on one plane of symmetry are related to the mesh nodes on the other side. 

Odd Periodic: If symmetry conditions exist, you can use the Odd Periodic boundary condition 
to model sections of a periodic structure with an odd number of poles. The mesh nodes on one 
plane of symmetry are related to the mesh nodes on the other side. 

Thin resistive sheet: Requires the user to specify the material name and sheet thickness. 
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Finite element mesh 

In the finite element method of analysis, the model is divided into a mesh of elements. The field 
inside each element is represented by a polynomial with unknown coefficients. The finite 
element analysis is the solution of the set of equations for the unknown coefficients.  

The accuracy of the solution depends upon the nature of the field and the size of the mesh 
elements. In regions where the direction or magnitude of the field is changing rapidly, high 
accuracy requires small elements or high polynomial orders (or a combination of both). 

ElecNet provides you with control over the size of the mesh elements. You can change the size 
of the elements for the entire model, or only in areas of interest.  

 

Adaption 

ElecNet's adaption process automatically identifies the areas of the mesh most in need of 
improvement and refines the mesh (h-adaption), or increases the polynomial order of the 
elements (p-adaption), in those areas.  

ElecNet's adaption is controlled by adaption options that are set before solving begins. These 
options determine: 

 the type of adaption method (h-adaption or p-adaption) 
 the percentage of elements of the mesh that are refined during each adaption step  
 the adaption convergence tolerance  
 the maximum number of adaption steps 

The Adaption Options are set in the Adaption Options properties page.  
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Solving the model 
ElecNet solves Maxwell's equations to find the electric field within the model. The solution can 
be Electrostatic, DC current flow, Time-harmonic, or Transient for either 2D or 3D models. 

ElecNet also offers an adaption process that automatically identifies and refines the areas of the 
mesh most in need of refinement to improve the quality of the solution. 

The computed electric fields are viewed as shaded, arrow, or contour plots or as field animations. 
In addition, ElecNet automatically extracts from the field solution certain parameters of interest 
(depending on the solution type). 

Electrostatic 
 Total electric stored energy 

 Force and torque on each body 

 Net charge on each electrode 

 Voltage across electrode 

DC Current Flow 
 Ohmic loss in each component 

 Total current flowing out of each electrode 

 Voltage across electrode 

Time-harmonic 
 Time-averaged electric stored energy 

 Time-averaged force and torque on each body 

 Net charge on each electrode 

 Time-averaged Ohmic loss in each conducting component 

 Total current flowing out of each electrode 

 Total displacement current for each electrode 

 Voltage across electrode 

Transient 
 Instantaneous electric energy 

 Force and torque on each body 

 Ohmic loss 

 Charge on electrodes 

 Conduction current on electrodes 

 Displacement current on electrodes 

 Voltage across electrode 


